




Teach Yourself VISUALLY™ Excel 365

Copyright © 2023 by John Wiley & Sons, Inc. All rights
reserved.

Published by John Wiley & Sons, Inc., Hoboken, New
Jersey.

Published simultaneously in Canada and the United
Kingdom.

ISBN: 978-1-119-93362-5

ISBN: 978-1-119-93363-2 (ebk.)

ISBN: 978-1-119-93364-9 (ebk.)

No part of this publication may be reproduced, stored in a
retrieval system, or transmitted in any form or by any
means, electronic, mechanical, photocopying, recording,
scanning, or otherwise, except as permitted under
Section 107 or 108 of the 1976 United States Copyright
Act, without either the prior written permission of the
Publisher, or authorization through payment of the
appropriate percopy fee to the Copyright Clearance
Center, Inc., 222 Rosewood Drive, Danvers, MA 01923,
(978) 750-8400, fax (978) 750-4470, or on the web at
www.copyright.com. Requests to the Publisher for
permission should be addressed to the Permissions
Department, John Wiley & Sons, Inc., 111 River Street,
Hoboken, NJ 07030, (201) 748-6011, fax (201) 748-6008,
or online at www.wiley.com/go/permission.

Trademarks: Wiley, the Wiley logo, Visual, the Visual
logo, Teach Yourself VISUALLY, Read Less - Learn More and
related trade dress are trademarks or registered
trademarks of John Wiley & Sons, Inc. and/or its affiliates.

http://www.copyright.com/
http://www.wiley.com/go/permission


Excel 365 is a trademark of Microsoft Corporation. All
other trademarks are the property of their respective
owners. John Wiley & Sons, Inc. is not associated with any
product or vendor mentioned in this book.

Limit of Liability/Disclaimer of Warranty: While the
publisher and author have used their best efforts in
preparing this book, they make no representations or
warranties with respect to the accuracy or completeness
of the contents of this book and specifically disclaim any
implied warranties of merchantability or fitness for a
particular purpose. No warranty may be created or
extended by sales representatives or written sales
materials. The advice and strategies contained herein
may not be suitable for your situation. You should consult
with a professional where appropriate. Further, readers
should be aware that websites listed in this work may
have changed or disappeared between when this work
was written and when it is read. Neither the publisher nor
authors shall be liable for any loss of profit or any other
commercial damages, including but not limited to special,
incidental, consequential, or other damages.

For general information on our other products and
services or for technical support, please contact our
Customer Care Department within the United States at
(800) 762-2974, outside the United States at (317) 572-
3993 or fax (317) 572-4002.

If you believe you’ve found a mistake in this book, please
bring it to our attention by emailing our reader support
team at wileysupport@wiley.com with the subject line
“Possible Book Errata Submission.”

Wiley also publishes its books in a variety of electronic
formats. Some content that appears in print may not be

mailto:wileysupport@wiley.com


available in electronic formats. For more information
about Wiley products, visit our web site at
www.wiley.com.

Library of Congress Control Number: 2022939049

Cover images: © 200degrees/Getty Images; Screenshot
Courtesy of Paul McFedries

Cover design: Wiley

http://www.wiley.com/


About the Author
Paul McFedries is a full-time technical writer. He has
been authoring computer books since 1991 and has
more than 100 books to his credit. Paul’s books have
sold more than 4 million copies worldwide. These books
include the Wiley titles Teach Yourself VISUALLY
Microsoft 365, Teach Yourself VISUALLY Microsoft
Windows 11, Microsoft Excel All-in-One For Dummies,
and Microsoft Excel Data Analysis For Dummies, Fifth
Edition. Paul invites you to drop by his personal website
at www.paulmcfedries.com or follow him on Twitter
@paulmcf or on Facebook at
www.facebook.com/PaulMcFedries.

Authors’ Acknowledgments
It goes without saying that writers focus on text, and I
certainly enjoyed focusing on the text that you will read
in this book. However, this book is more than just the
usual collection of words and phrases designed to
educate and stimulate the mind. A quick thumb through
the pages will show you that this book is also chock-full
of treats for the eye, including copious screenshots,
beautiful colors, and sharp fonts. Those sure make for a
beautiful book, and that beauty comes from a lot of
hard work by the production team at Straive. Of course,
what you read in this book must also be accurate,
logically presented, and free of errors. Ensuring all of
this was an excellent group of editors that I got to work
with directly, including project manager Lynn Northrup,
technical editor Joyce Nielsen, content refinement

https://www.paulmcfedries.com/
https://www.facebook.com/PaulMcFedries/


specialist Archana Pragash, copyeditor Elizabeth Welch,
and managing editor Christine O’Connor. Thanks to all
of you for your exceptional competence and hard work.
Thanks, as well, to associate publisher Jim Minatel for
asking me to write this book.



How to Use This Book
Who This Book Is For

This book is for the reader who has never used this
particular technology or software application. It is
also for readers who want to expand their
knowledge.

The Conventions in This Book

 Steps

This book uses a step-by-step format to guide you easily
through each task. Numbered steps are actions you
must do; bulleted steps clarify a point, step, or optional
feature; and indented steps give you the result.

 Notes

Notes give additional information — special conditions
that may occur during an operation, a situation that you
want to avoid, or a cross-reference to a related area of
the book.

 Icons and Buttons

Icons and buttons show you exactly what you need to
click to perform a step.

 Tips



Tips offer additional information, including warnings and
shortcuts.

 Bold

Bold type shows command names, options, and text or
numbers you must type.

 Italics

Italic type introduces and defines a new term.
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CHAPTER 1
Getting Started with Excel

You use Microsoft Excel to create spreadsheets, which are
documents that enable you to manipulate numbers and
formulas to quickly create powerful mathematical, financial,
and statistical models. In this chapter you get some
background about Excel, learn how to access the desktop
and online versions of the program, and take a tour of the
program’s features.

Getting to Know Excel
Start Excel on the Desktop
Navigate to Excel for the Web



Tour the Excel Window
Work with the Excel Ribbon



Getting to Know Excel
Working with Excel involves two basic tasks: building a
spreadsheet and then manipulating the data on the
spreadsheet. Building a spreadsheet involves adding data
such as numbers and text, creating formulas that run
calculations, and adding functions that perform specific
tasks. Manipulating spreadsheet data involves calculating
totals, adding data series, organizing data into tables, and
visualizing data with charts.
This section gives you an overview of these tasks. You learn
about each task in greater detail as you work through the
book.

Build a Spreadsheet
Add Data

You can insert numbers, text, and other characters into
any cell in the spreadsheet. Click the cell that you want to
work with and then type your data. Your typing appears in
the cell that you selected, as well as in the formula bar,
which is the large text box above the column letters.
When you are done, press Enter. To edit existing cell data,
click the cell and then edit the text in the formula bar.



Add a Formula

A formula is a collection of numbers, cell addresses, and
mathematical operators that performs a calculation. In
Excel, you enter a formula in a cell by typing an equal sign
(=) and then the formula text. For example, the formula
=B1 – B2 subtracts the value in cell B2 from the value in
cell B1.

Add a Function



A function is a predefined formula that performs a specific
task. For example, the AVERAGE function calculates the
average of a list of numbers, and the PMT function
calculates a loan or mortgage payment. You can use
functions on their own, preceded by =, or as part of a
larger formula. Click Insert Function ( ) to see a list of
the available functions.

Manipulate Data
Calculate Totals Quickly

If you just need a quick sum of a list of numbers, click a
cell below the numbers and then click the Sum button ( ),
which is available in the Home tab of the Excel Ribbon.
You can also select the cells that you want to sum, and
their total appears in the status bar.

Fill a Series



Excel enables you to save time by completing a series of
values automatically. For example, if you need to enter
the numbers 1 to 100 in consecutive cells, you can enter
just the first few numbers, select the cells, and then click
and drag the lower-right corner to fill in the rest of the
numbers. With Excel you can also fill in dates, as well as
the names for weekdays and months.

Manage Tables

The row-and-column format of a spreadsheet makes Excel
suitable for simple databases called tables. Each column



becomes a field in the table, and each row is a record. You
can sort the records, filter the records to show only certain
values, and add subtotals.

Add a Chart

A chart is a graphic representation of spreadsheet data.
As the data in the spreadsheet changes, the chart
automatically changes to reflect the new numbers. Excel
offers a wide variety of charts, including bar charts, line
charts, and pie charts.



Start Excel on the Desktop
Before you can perform tasks such as adding data and
building formulas, you must first start the desktop version of
Excel. This brings the Excel window onto the Windows
desktop, and you can then begin using the program. In this
section, you learn how to start Excel in Windows 11, but the
steps are similar if you are using Windows 10.
This task assumes that you have already installed Excel 365
on your computer. If you prefer to use Excel on the web, see
the next section, “Navigate to Excel for the Web.”

Start Excel on the Desktop

 Click Start ( ).



The Start menu appears.
 Click Excel.
The Microsoft Excel window appears on the desktop.

Note: Click Blank workbook to open a new Excel file.



Navigate to Excel for the Web
If you want to work with Excel online instead of on the
desktop, you need to know how to use your web browser to
navigate to the Excel for the web version of the program.
With your Microsoft 365 subscription, you get access to both
the desktop and online versions of each app, including
Excel. This book uses the desktop version of Excel for its
example screens. Fortunately, Excel for the web uses the
same layout as the desktop version and offers mostly the
same features, so everything you learn in this book applies
to Excel for the web.

Navigate to Excel for the Web

 Click Start.



The Start menu appears.
 Click Edge.

 If you have Edge pinned to the Windows taskbar, click
the Edge icon ( ) instead of following steps 1 and 2.
The Microsoft Edge web browser window appears.

Note: If you prefer to use a different web browser, start that
browser instead of Edge.

 In the address bar, type www.office.com/launch/excel
and press .
 If prompted, enter your Microsoft 365 username and
password (not shown).
The Excel for the web app appears.

https://www.office.com/launch/excel


Note: Click New blank workbook to open a new Excel file.



Tour the Excel Window
To get up to speed quickly with Excel, it helps to understand
the various elements of the Excel window. These include
standard window elements such as the title bar, window
controls, and status bar; Office-specific elements such as
the Ribbon and File tab; and Excel-specific elements such as
the worksheet.
If you are using Excel for the web, note that the window you
see is nearly identical to the Excel desktop window. The
main exception is that, by default, Excel for the web
displays a simplified version of the Ribbon.

 Title Bar
The title bar displays the name of the current workbook.

 Ribbon Tabs
You use these controls to display different sets of Ribbon
commands.



 Ribbon
This area gives you access to all the Excel commands,
options, and features. To learn how to use this element,
see the following section, “Work with the Excel Ribbon.”

 Workbook Window Controls
You use these controls to minimize, maximize, restore,
and close the current workbook window.

 File Tab
Click this tab to access file-related commands, such as
Save and Open.

 Worksheet
This area displays the current worksheet, and it is where
you will do most of your Excel work.

 Status Bar
This area displays messages about the current status of
Excel, the results of certain operations, and other
information.



Work with the Excel Ribbon
You use the Ribbon to access all the features, commands,
and options in Excel. The Ribbon is organized into tabs, such
as Home, Insert, and Page Layout, and each tab contains a
collection of related controls. For example, the Insert tab
contains controls related to inserting objects into a
worksheet, while the Formulas tab contains controls related
to building formulas. Each tab usually includes buttons, lists,
and check boxes.
The File tab is a bit different because it displays the
Backstage view, which contains controls related to working
with Excel files, such as opening, saving, and printing them.

Work with the Excel Ribbon

 Click the tab that contains the Excel feature you want to
work with.
Excel displays the controls in the tab.


